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Abstract

Horvath, P., Barton, D.N., Hauglin, E.A. & Ellefsen, HW. 2017. Blue-Green Factor (BGF) map-
ping in QGIS. User Guide and Documentation - NINA Report 1445. Norwegian Institute For Na-
ture Research.

The blue-green factor (BGF) is a rapid assessment tool to help quantify minimum municipal re-
quirements for surface water management, vegetation qualities and biodiversity in outdoor areas
of property developments. BGF-QGIS makes it possible to calculate the blue-green factor for
larger areas than in the original Excel-based methodology, by taking advantage of remote sens-
ing data, GIS datasets, and CAD-based design proposals. It also provides a flexible platform for
adjusting the scoring of blue-green qualities to suit specific local conditions and priorities.

Peter Horvath, GEco Research Group — Natural History Museum
David N. Barton, Norwegian Institute for Nature Research (NINA)
Espen Aukrust Hauglin - Oslo College of Architecture and Design (AHO)
Halvor Weider Ellefsen, Oslo College of Architecture and Design (AHO)

Contact: david.barton@nina.no
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Sammendrag

Horvath, P., Barton, D.N., Hauglin, E.A. & Ellefsen, HW. 2017. Blue-Green Factor (BGF) map-
ping in QGIS. User Guide and Documentation. NINA Raport 1445. Norsk institutt for
naturforskning

Blagrenn faktor (BGF) er et verktgy som kvantifiserer krav til uterom nar det gjelder vann-
handtering, vegetasjon og biodiversitet i byggesaksprosjekter. BGF-QGIS gjgr det mulig a
beregne BGF for flere eiendommer og stagrre arealer enn i den opprinnelige Excel-baserte
metoden, ved & ta i bruk digitale kartleggingsverktgy som integrerer fiernmalingsdata, GIS
dataset og CAD-basert design. QGIS plattformen gjer det ogsa mulig for enkelt-kommuner a
tilpasse BGF metoden til lokale forhold ved a endre kriterier og vekter.

Peter Horvath, GEco Research Group — Naturhistorisk Museum
David N. Barton, Norsk Institutt for Naturforskning (NINA)
Espen Aukrust Hauglin, Arkitekthgyskolen i Oslo (AHO)

Halvor Weider Ellefsen, Arkitekthgyskolen i Oslo (AHO)
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Foreword

The BGF-QGIS application was made possible thanks to the original Blue-green factor method-
ology developed in 2014' by PBE- Oslo Kommune, Baerum Kommune, Dronninga Landskap,
COWI and C.F. Mgller, with the support of the Cities of the Future Project, funded by the Norwe-
gian Ministry of Local Government and Modernisation.

The clear and easily implementable BGF method (2014) using Excel spreadsheets was the basis
for the later development of an Android app called “BG Calculator”. The authors of this Docu-
mentation gratefully acknowledge the origins of the methodology and the support from different
NINA coordinated projects to develop the BGF tool further. The Android App development was
supported by the EU FP7 project OpenNESS (2012-2016). Programming of the BGF-QGIS ap-
plication by Peter Horvath was funded by the ENABLE project, supported by the Biodiversa pro-
gramme at the Norwegian Research Council. A BGF-QGIS beta version was tested and im-
proved with support of the URBAN EEA project, funded by the Miljgforsk programme of the Nor-
wegian Research Council.

We are grateful to Yuan Wang, University of Helsinki, and students at the Oslo School of Archi-
tecture and Design (AHO) course “By og Arkitektur” Autumn 2017, for testing the BGF-QGIS and
suggesting improvements.

David N. Barton
Project coordinator ENABLE Oslo and URBAN EEA
Oslo, December 2017

! Framtidens Byer, Blagrgnn faktor. Veileder byggesak. Hoveddelen 28.01.2014. 2014, Plan og bygningsetaten, Baerum
Kommune, Dronninga Landskap, COWI, C.F. Mgller.
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1 Introduction

1.1 What is BGF?

Blue-green factor (BGF) is a tool to assess an urban
property development’s surface water management and
vegetation qualities. It uses classification of blue-green
areas and additional qualities to calculate a total BGF fac-
tor per property area. It was developed by the Project Fu-
ture Cities (Figure 1) and explained in a 2014 Guidance
Manual for building permits (Figure 1).

1.2 Approaches to calculating BGF

The 2014 BGF Guidance Manual uses a spreadsheet
calculator in MS Excel to determine the total blue-green
factor of a property area. The user identifies the area for
blue and green surfaces, and blue and green ‘additional
qualities’. The BGF score is calculated as an area-
weighted sum of surfaces and additional qualities (Figure
2). The Excel spreadsheet (Figure 3) required areas to
be calculated beforehand (i.e. in the field or from a plan-
ning map). In addition, the calculations were limited to
one property per spreadsheet and no graphical/map out-
put was available. The practical implementation was thus
limited.

The OSLOpenNESS project developed an Android appli-

cation — BGF calculator? - to make the BGF accessible to

a wider public on Smartphones. The BGF calculator uti-

lized both the calculator and integrated a spatial repre-

sentation of blue-green structures using satellite images

in Google Maps. The total property BGF could be auto-
matically calculated by mapping the blue-green structures
within the property using the satellite image. The Android
BGF Calculator App also had limitations. It was only avail-
able on Android, with minimal customization. Surface ar-
eas could be digitised using a stylus on a pad, but was
inaccurate when using ones fingertip. The App could not
utilize property cadastre boundaries to delineate individ-
ual properties. Furthermore, the App only stored BGF pro-
jects on the Smartphone’s internal memory with no import
or export functions to a database. The BGF Calculator
App only contains a simple export function of a csv file of
the data via e-mail.

FRAMTIDENE BYER

=GR Plan- og

S bygningsetaten BARUM KOMMUNE

COWL
Figure 1. Blue-green factor Guidance
Manual for building permits, developed by
the Future Cities Project. Source: Framti-
dens Byer, Blagrenn faktor. Veileder byggesak.
Hoveddelen 28.01.2014. 2014, Plan og byg-

ningsetaten, Bserum Kommune, Dronninga
Landskap, COWI, C.F. Mgller.

DRONNINGAL ANDSKAP C.F.Meller

Blue-green

-
SUIACEs Additional

green qualities

ecologically
effective
surface
area

Figure 2. The blue-green factor is an area

weighted sum of blue-green surfaces and
additional qualities

total
property
area

= BGF

2 The BGF Calculator App for Android is available here: https://play.google.com/store/apps/de-

tails?id=no.nina.bgf app&hl=en



https://play.google.com/store/apps/details?id=no.nina.bgf_app&hl=en
https://play.google.com/store/apps/details?id=no.nina.bgf_app&hl=en
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Blue Green Factor (BGF) 29.05.2013 Developed for Berum og Oslo municipalities by Dronninga landskap, COWI and CF Mgller
Valui - |Symbol |- |Factor - |Descrip‘tian - |ARE - |BGI -
Plot Area (including the built ares) Fill out the area 0
1.BLUEGREEN AREAS
\Open permanent water surface that can Permanent water surface lied rai from the site, dless of whether thisisa
1 receive raimater channel with concrete bottom stream with green banks or other type of water surface. Only the
B water surface is ¢ idered 0 0
ially sexrface Ho o, Hard surfaces with permeability, providing infiliration. For example, grassy areas reinforced with
03 hed stone, and rel prasssurface (concrete, gravel or crusshed stone. Not surfaces of underlying hard vers if the soil depth is less
than 80 am. 0 0
rfaces with dral Eg. tonarete, asphalt, roofs and paving stones. Calculated for the area coresponding to the size
an open drai of the vegetation surface that accepts water. The drainage magazine must have the apadty
0.2 magazine acoording to municpal requirements for discharges o offidal sewer system {ie it holds about 20
il to 301 f m? runoff area}
0 0
urfa with drais Eg. conarete, asphalt, reof surfaces with runcff led to a dosed fadlity for retention and
- purification of the water. This also applies to underground solutions combined with irigation of
0.1 trees. The whole area counts assuming drainage magazine is according to munidpal
O requirements for discharges to off. sewer system {ie itholds about 20 to 301 f m? runoff area}.
[} [}
| |surfaceswith i i il growingin soil and has mntact with the soil below. Benefidgal for the development
1 —LU—L-M or bedrock of flora and fauna and storm water can be pulled down to ground water. The point also applies
to natural rock outarops and diffs. 0 0
x | |Surfaces vith fion, not & growing in soil on minnimum 80 an depth, but not in ntact with the earth f
0.8 UL ULl | with soil> 80 can ground below, eg. on top of a garage or roof. The depth is great encugh that larger trees can
ETOW. 0 0
Surfaces with vegetation, not associted As above, but with 40-80 cm ear so that hedges, large bushes and small or medium rees can
0.6 LI T o s o0 - 80 p—
0 0
Surfaces with vepeltation, not associated As above, but with 20-40 am earth for that perennials and small bushes can grow.
04 1
[} [}
Surfaces with vepeltation, not associated As above, but with 5 - 20 am earth that is encugh for grasses, herbaceous plants and other
0.2 |zt il s sols 200m ground cover can grow.
0 0
2. Additional qualities = Blue and Green additional qualities that give extra points. Th area can therefore b number of times below
Blue additional qualities
Natural edges to water srufaces Water surfaces that are counted above, can also be counted in this category there is access for
03 —I"L._)J'_ flora / fauna at ground level to a natural substrate and edge (riparian) zone. Eg: stream, canal
- and pond with green edges The area to be considered is the width of the water surface.
0 0
Raiin bed or equialent Vegetation area that serves asrain bed or similar planted infiliration that collects, diffuses and
0.3 :L::llndclt infiltrates rainwater into the soil f ground. This doesnot apply to permanent water surfaces and
L diffusion basin counted in blue surfaces above.
Green additional qualities, Points below (trees) should be filled in as a number Number
bisting brpetrees > 10 m Existing large trees; over 10 m. factor is 25 m2ftree _
1 I
Existing Wrees that can be expected o prow | Existing trees that can be over 10 m tall. Forest trees, hardwood deciduous trees and park trees,
0.8 T o ower > 10 m eg, elm, ash, birch, oak, linden, maple, chestnut, pine and many more. It is expected that the
tree should have enough soil to grow {min 100 am}. Factor: 25 m2/tre {x 0.8}
Exbting frees that can be expected o grow  |Existing trees that are 5-10 m tall. Omamental trees and fuit trees, eg,, apples cherry,
0.6 ( JT [0 be smnall o medimn, 5 - 10 m magnolia, pear, looust and many more. Also applies to pruned trees. It is expected that the tree
should have enough soil to grow {min 60 cm}). Factor: 16 m2ftree {x 0.6}
7 | Mewly planted trees that are experted to be [Trees that will be over 10 m high. Species: see the field listed above. It is expected that the tree
0.7 > 10 m will have enough soil to grow {min. 100 an}. Factor: 25 m2/tre {x 0,7).
9 gh grow { ) 0,7},
T Mewly phnted trees that are expeded o be (Trees which will become 5-10 m high. Species: see the field above. It is expected that the tree
.. 5-10m N o ) .
0.5 Q will have enough soil to grow {min 60 an}- Factor: 16 m2ftre {x 0,5}.
Points below should be filled in as m2 Area m2
Natire vepelaion Establishing or protection of surfaces with a large content of valuable plant species that are a
0.6 @_ﬂ' ) part of the local, historical natural and cultural land:
) Herges, bushes and multi-stemmed trees with a height over 2 m. G Tor amaximal area i
0.4 [to the drip zone of {oown of the tree) m2/tree.
Greenvals For climbing plants and other green walls, the factor is caloulated for the wall area that can be
0.4 m p d to be covered over the course of 5 years {a maximum of 10 m height for climbing
plants).
i o i Does not apply to lawn grasses
03 | . -
J'_I_U.Ili
Configuous preen areas over 75 m2 Contiguous green area that is larger than 75 m2, as for example large grassy lawns, pllanted
0.1 75m2 areas, or others.
Points below are filled in with the number 0,05 0.05
' (¥ ion o existis £r If the blue and f or green elements in the area can be connected to the existing structure
) outside the area in question. The ion should be obvi For le, a stream
0.05 \ opening, a link to the existing channel or water surface, drainage, the extension of an alleyor a
grove, merging of several courtyards with free b them. This provides a general
|increase of 0.05 in BGF.
TOTAL BLUEGREEN FACTOR (BGF) Hit

Figure 3. Facimile of the MS Excel calculator in the original BGF methodology (Fremtidens Byer
2014) (original in Norwegian)
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The above mentioned limitations led to development of an integrated scheme interface in QGIS
to calculate BGF. QGIS is an open-source Geographic Information Software (GIS) for viewing,
editing, and analysis of geospatial data.

The motivation was to improve and include the following processes:

o Ability to use BGF process directly in the field (in addition to office use)

e Utilize multiple ortho-photos and/or satellite images (e.g. to switch between summer and
winter images — to map both the canopy and understorey vegetation)

e Use additional GIS land cover layers to support further appraisals such as ecosystem ser-
vices

e Use additional spatial structures (such as property boundaries) and data (e.g. for snapping
or as aggregation units...) to aid the mapping process.

o Possibility to adjust weighting of BG structures in the future

e Producing map outputs of different property areas or scenarios

e Customizing interface

By using the Free and Open Source Software QGIS, one can accomplish all of these goals within
a highly customizable and user-friendly interface.

1.3 Using BGF-QGIS in urban planning

The original BGF methodology was intended as a tool to support the integration of blue and
green structures in building and landscape architectural design at property level. It opened up
the possibility of municipalities providing recommendations or requirements for a minimum BGF
scores that should be achieved within the delimited area of single properties. BGF guidance
(2014) proposed that minimum BGF scores be differentiated according to the density of inner
and outer city areas.

However, the evaluation of minimum requirements for BGF scores at the level of neighbour-
hoods, encompassing several properties with different forms of program, ownership and land-
scape characteristics was not easy to evaluate using the original BGF methodology. By enabling
BGF in a QGIS platform, it is possible to cost-effectively map existing blue-green structures by
means of integrating remote sensing data, GIS datasets, and CAD-based design proposals.

BGF-QGIS thus makes it possible to evaluate alternative planning and design scenarios using
BGF methods for larger areas. This should make the BGF mapping and valuation methodology
an assessment tool that is useful also in planning and urban development processes. Further-
more, the BGF-QGIS methodology applied within urban planning and development provides an
efficient quantitative measurement tool. It makes quantification of blue-green surfaces and qual-
ities equally available as other forms of quantitative planning and design data. BGF in a QGIS
platform not only enables data collection in larger areas than before, but also accentuates and
visualizes environmental amenities that have often been undervalued in urban planning pro-
cesses.

One size does not fit all. In this QGIS application, users can adapt the BGF methodology to
include new blue-green structures, as well as change the relative importance of each structure
in the total BGF score. This makes it easier to adapt the methodology to particular needs and
conditions of different municipalities.

10
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1.4 BGF method modifications implemented in BGF-QGIS

During the development of BGF Calculator App we recognised that ‘trees’ in the original BGF
method required an adaptation for stands of trees where it is impractical to count individual trees.
We implemented an option where tree crown cover could be mapped, while keeping the original
option of entering the individual number of trees on a property. In the original BGF methodology,
individual trees are assumed to have standard canopy area depending on their height classifica-
tion. BGF users had to have knowledge of tree height in order to implement this function.

In BGF-QGIS we have simplified the idea of tree canopy mapping further. The user now maps
the tree canopy area of individual trees, as well tree stands, in the same way, by digitising canopy
cover. While tracing canopy sizes for individual trees is moderately more time consuming than
entering a number for different tree sizes on the property, canopy mapping provides an accurate
estimate of tree canopy. This mapping can be validated against ortho-photos. Considering the
structural importance of trees for ecosystem functions this is a feature that responds to the pur-
pose of the original BGF methodology, as well meeting future needs for detailed mapping of
urban ecosystem qualities.

11
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2 Set up and getting started

2.1 Get the basic overview of GIS

Before beginning with BGF-QGIS, it is highly recommended to get briefly familiarized with the
basic knowledge about GIS, for example by going through the following easy step-by-step intro-
duction tutorials:
e GIS systems (http://docs.qgis.org/2.14/en/docs/gentle_gis_introduction/index.html)
¢ QGIS software and interface (http://docs.qgis.org/2.14/en/docs/training_manual/in-
dex.html)

2.2 Required QGIS version & plugins

This project was built under version of QGIS 2.18.11 'Las Palmas' that was released on
21.07.2017. It is recommended to use the latest available version of QGIS software (but NOT
older than mentioned above).

To obtain your version of QGIS, follow the link below:
https://www.qqis.org/en/site/forusers/download

All the required project files that will be used in this tutorial are available for download at
GitHub https://github.com/peterhor/BGF-QGIS

2.3 Installation Workflow

Please follow this workflow in order to avoid structural problems within BGF-QGIS
1) Install QGIS
2) Install required plugins
3) Download folder structure from GitHub
3) Open project and start Mapping

2.4 Required Plugins

In order for the BGF-QGIS project to work correctly, you need to have specific plugins installed
in QGIS. Please install all plugins BEFORE opening the BGF project in QGIS.

o Form value relation
» Form value relation plugin implements of complex dynamic filters
and makes available multi-level relations and dependencies be-
tween the drop-down items in the fill-in forms.
= https://www.itopen.it/a-new-qgis-plugin-allows-dynamic-filtering-of-
values-in-forms/

o refFunctions
= refFunctions utilizes a more flexible Field calculator functions in
QGIS and allows to control behaviour between different layers
= hitps://geogear.wordpress.com/2014/11/13/reffunctions-v1-0/

12
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2.5 Optional Plugins

o QGIS Cloud Plugin
= Qgis Cloud Plugin is a powerful Web-GIS platform for publishing
maps, data and services on the internet.
= http://qgiscloud.com/
o Other options for publishing include qgis2web, QGISQUICK, Lizmap

2.6 Installing Plugins

Installing plugins is available through the following menu:
Plugin -> Manage and Install Plugins... ->

Choose the abovementioned plugins and hit “install plugin” .

/! Plugins | All (497) i o S|
& Al Search |f | a

'+ EqHazard -

] All Plugins
F :InsL—:IIed

.

Mot installed

ﬁ Settings

Continue by installing all three required plugins: “Form value relation”,

Cloud Plugin”.

[Ciaevis

=k

i Expressions Plus
44 Feature Grid Creator
4 Feature Iterator
++ Feature Loader

44 FieldPyculator

4 First Aid

44 Floodrisk.

4+ Flow Estimator

44 Flow Trace

4+ FlowMapper

i+ FlowPathDown_BB

i : Form Value Relation |

i Freehand Editing
{4 Freehand raster georeferencer
4 GarminCustomMap

& GdalTools

- GEarthView

4 Genetic Line Simplifier
i+ GeoAdmin Search

44 GeODINQGIS

4t GeoHealth

i GeolSOMPlugin

[ Geometry Checker
[ #7x Geometry Snapper

- Geometry Updater
4% GeopaparazziTags converter
4 geopunt4Qais

o

m. |

1

On the left you see the list of all plugins available
for your QGIS, both installed and available for
download. Some plugins come with your QGIS
installation while most of them are made available
via the plugin repositories.

You can temporarily enable or disable a plugin. To
enable or disable a plugin, click its checkbox or
doubleclick its name...

Plugins showing in red are not loaded because
there is a problem. They are also listed on the
'Invalid' tab. Click on the plugin name to see more
details, or to reinstall or uninstall this plugin.

Upgrade all Uninstall plugin Reinstall plugin

J

[ Close Help

]

"W

refFunctions”, and “Qgis

IMPORTANT! Open BGF-QGIS project only after all three plugins are installed. If not the added
functionality will not be available in the project.

2.7 Opening a BGF-QGIS project

You can open the QGIS project file “BGF_qgis_project.qgs” directly from your file browser. Al-
ternatively you can navigate to the project file “BGF_qgis_project.qgs” through an already
opened instance of QGIS:

Project -> Open (Ctrl+O)

13
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The project is now directly prepared for you to start mapping (skip to section 4 Digitizing BGF
Structures). However, if you want to customize or add additional Web Map Services or Ras-
ter/Vector layers, start by following the sections below: 3.1 How to add WMS and 3.2 Adding
raster / vector files from disk.

A backup copy (preferably zipped) should be kept in case you need to recover your project or
start over.

2.8 Adding additional background data

A Web Map Service (WMS) is a standard protocol for serving georeferenced map (over the In-
ternet) images which a map server generates using data from a GIS database.

Since it is streamed over internet, it does not take up space in your final project, such as ras-
ter/vector data would. However, the disadvantage it has over raster/vector files stored locally is
that its structures are not editable/trackable within the project other than visually. Also you have
to be ONLINE and with a good internet connection for accessing WMS. Otherwise rendering
WMS can be slow and make mapping less efficient. This can be an obstacle in the field.

This is an OPTIONAL step for those who want to have additional maps form the WMS. You can
add WMS layer from different servers by using their URL link. Do this by following:

1. Layer -> Add Layer -> Add WMS/WTMS Layer

Layer | Settings Plugins Vector Raster Database Web Processing Help
™ T
Create Layer 3 r: I0) LL ) [ ¢ ] ] F_j ﬂ_}
Add Layer P | VG Add vector Layer... Ctrl+Shift+V
Embed Layers and Groups.... ¥ AddRaster Layer... Ctrl+5hift+R
Add from Layer Definition File.... W Add PostGIS Layers... Ctrl+5hift+D
Copy style /% Add Spatialite Layer.. Ctrl+Shift+L
Past style ﬁ?‘ Add MSSQL Spatial Layer... Ctrl+Shift+M
&), Add DB2 Spatial Layer... Ctrl+Shift+2
Trzollin i bt @, Add Oracle Spatial Layer... Ctrl+5hift+0
J/ Toggle Ediing | 6 Add WMSMMTS Layer... Ctrl+Shift+W ||
Szl Bis B Add Arcals MapServelayer, . |
Current Edits Q Add WCS Layer...
Save As... WV Add WFS Layer...
Save As Layer Definition File... &5 Add ArcGIS FeatureServer Layer...
|1 Remove Layer/Group Ctrl4+D 90 Add Delimited Text Layer...
] Duplicate Layer(s) 141 Add/Edit Virtual Layer...
2. Add NEW service
7, Add Layer(s) from 2 WMT)S Server B
(Basiskart B3
[ comect | [ mew, |[ Eat ][ oeete ad | [ save | [adddefouit servers| |
i} Name i Title Abstract
Tmage encoding
options
Tile size
Feature limit for GetFeatureInfo
WGS 84/ UTM zone 32M ange...
7] Use contextual WMS Legend
Layer name
Close: Help.
Ready

14
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3. Type in link to a desired WMS server and name it accordingly. In our case type the
following link to "FKB” WMS server.

http://wms.geonorge.no/skwms1/wms.fkb3?service=WMS&request=GetCapabilities

==

./ Create a new WMS connection

Connection details

Mame FKB

URL

Authentication | Configurations

If the service requires basic authentication, enter a user name and optional password

|http: /fwms.geonorge.nojskwms 1 wms. fkb3?service =\hMS arequest=GetCapabilties |

User name

Password

Referer

DPI-Mode [al

Veersion
[] Ignore GetMap/GetTile URI reported in capabilities
[ 1gnore GetFeatureInfo URI reported in capahilities
[7] 1gnore axis orientation (WMS 1.3/WMTS)

[7] tnvert axis orientation

[7] smooth pixmap transform

] [ cancel

J |

Help

[ ok

4. Click “connect”

5. Choose desired layers to be displayed in QGIS:

E.g. ID 134 for vector layers (example “Eiendomskart” ) — IMPORTANT: Choose
PNG encoding

8. o]

-
# Add Layer(s) from a WM(T)S Server

Layers | Layer Order | Tiesets | Server Search |
3 <)
| comect J[ mew ][ Edt || peete | [ toad |[ Sawe | [adddefoult servers|
o Name Title Apstract
a0 FKB3_WMS FKB3 WMS Tienesten inneholder FKB data | storre milestokk en 1:12000
> 1 _markslag FKE Markslag fb_markslag
7 b arealbruk  FKE Arealbruk  fib_arealbruk
> 13 fb_terrengform @ Terrengform  fib_terrengform
> 27 fio_vann FIE Vann fid_varn
> 45 fib_samferdsel  FKB Samferdsel  fkb_samferdsel
) fih byag og anl_ FKBEyggoganle fib byag og anler
7 133 Tib_eiendomskart KB Eiendomskart  fkb_eiendomskart
4 134 eiendomsgrense  Eendomsgrense
default default
T 136 orensepunkl Grensepunkt
138 default default
> 138 fkb_presentasjon... FKE Fresentasjon... fkb_presentasjonsdata
Image encoding
) PNGB ) IPEG
G System (79
Tile size
Feature limit for GetFeaturelnfo i
s 24U e 3
[T Use contextual WMS Legend
Layer name  default
I 7 | cese || Hep
1Layer(s) selected
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6. You can also add some other useful and freely available WMS services. These in-
clude the Norwegian Common Geo-Database “FKB”, where you find layers about
data:

AR5 —land use

Contour lines

Water bodies

Transport network

Buildings

Properties

g. Object/city names and labels

-0 Q00T

http://wms.geonorge.no/skwms1/wms.fkb3?service=WMS&request=GetCapabilities
Please note: This data is freely available and the publisher GeoNorge reserves against
the accuracy of the data - data could be outdated. Also note that some of these WMS
layers are only visible at a certain extent (i.e. You have to zoom in/out in order for the
map to be shown)

7. Alternatively, if you are a subscriber of “Norge-Digitalt lisens”, you can access the
most accurate and up-to-date “Matrikkelen” WMS services of all Norwegian munici-
palities through GEONORGE.no webportal.

http://wms.geonorge.no/skwms1/wms.matrikkel.v1?

The satellite/aerial images are usually labelled with a year they were taken. It is a good
practice to use a couple of images, preferably from different seasons of the year. This
way you can see both the ground cover (on an autumn/winter image without leaves) and
the canopy cover (on a spring/summer image).

8. For other FREE raster base-maps install Plugin “OpenLayers Plugin” (following in-
structions from 2.2 Required Plugins). After installing, make sure to add desired
layers

- Processing  Help

: MetaSearch 4 :: ﬂ.‘ - ’ > g

Vg S

'{L\ QuickMapServices 3 .

l. OpenLayers plugin 4 | Openlayers Overview

v ) ) 5 I Terms of Service / About
| |

d

OpenStreetMap

- 8

Google Maps

Bing Maps
Q5M/Stamen
Wikimedia Maps
Q5M/Thunderforest

* v vy v v v -

1M e

Apple Maps

Another alternative of FREE raster base-maps is a plugin called “QuickMapServices”.

16
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2.9 Adding raster / vector files from disk

If you want to use some other raster / vector files from your computer, follow this path:

1. Layer -> Add Layer -> Add Raster Layer / Add Vector Layer

Layer | Settings Plugins Vector Raster Datsbase

Web Progessing Help

Create Layer 3 f: I¢ D L»“ ,.N‘_{ ( LI - ﬂ?
Add Layer * |V Add Vector Layer... Cirl+5hift+V
Embed Layers and Groups... |'E Add Raster Layer... [ CirlshiftR
Add from Layer Definition File... W, Add PostGIS Layers. . " Ctrl+Shift+D
Copy style #7 Add Spatialite Layer... Cirl+Shift+L
Paste style ’_’ Add M330L Spatial Layer... Ctrl+5hift-+M
@, Add DB2 Spatial Layer... Ctrl+shift+2

CEEEITEIR R = @, Add Orade Spatial Layer... Cirl+Shift+0
Toggle Editing G Add WMS/WMTS Layer... Cirl+Shift-w
Tl e @ Add ArcGIS MapServer Layer...
Current Edits %3 Add WCS Layer...
Save As... &% Add WFS Layer...
Save As Layer Definition File. .. &7 Add ArcGIS FeatureServer Layer...

[l Remove Layer/Group Ctrl+D ,;: Add Delimited Text Layer...

] Duplicate Layer(s) W Add/Edit virtual Layer...

2. Navigate to desired files. Most commonly used vector files are marked with file exten-
sion “shp”, or shapefile. Raster files need to be georeferenced and the common file for-

mat is geoTIFF or “tiff’.
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3 Mapping BGF Structures

The main part of this tutorial is about digitizing urban structures and determining their total BGF.
The tutorial is divided into three parts in which you first outline your desired locality (for example:
parcel bounded by property borders — in our case municipality directorate). Then you begin with
mapping/describing each particular Blue-green Structure for this locality and finish by adding
Additional Qualities. In this tutorial we will map the Governor’s property in As.

3.1 Locality level

This is where you delineate your locality. During this first part we will be working only within layer
“BGF_locality_area”. Thus, start by selecting layer “BGF_locality_area” in the Layers Panel
View -> Panels -> Layers Panel

1. Activate editing for the layer “BGF_locality_area”, by clicking on the “Toggle Editing”
pencil.

Project Edit View Layer Settings Plugins Vector R

HEBRLE ﬂ@@"""
/B R R R @ €8

v,, Layers Panel
Q& @1 @v“f &~ A0

o ! BGF_flate
(] M| [ WMS_raster_data

@ . < [ sveumc
Py 4 [ B EIENDOMSKART
M 4 [7] [ orToFOTO13

4 [7] B FLYFOTO14

& | ‘%

2. Click “Add feature”to add new polygon

Project Edit View Layer Settings Plugine \Vector Raster

NEBERLR 40D H 0
&.'fr\u‘:u CBF" gD
v‘, LayersPane_Ib\f_ =
il m@,m_

=

'g ; | BGF_flate -
ﬁ ;»,ﬁﬁ BGF locality_area

© | 4 @ @ wMs_raster data v
@ - 4 [ B sveunG
_ 4 [ B ExEnDOMSKART Tl
v 4 [7] B ortoFoTO13
@ 4 [7] B rLyroTO14 Il
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3. Begin digitizing

a. Turn on ADVANCED DIGITISING TOOLBAR by right-clicking anywhere on the
panels

Panels

<

OGIS Cloud
i Toolbox Ctrl+Alt+T
Advanced Digitizing Panel
AutoFields
v Browser Panel
Browser Panel (2)
GPS Information Panel
Layer Order Panel
Layer Styling
v Layers Panel
Log Messages Panel
Overview Panel
@) searchQMs
Spatial Bookmarks Panel
v Statistics Panel
Tile Scale Panel
Undo/Redo Panel
User Input Panel

Toolbars
—
v’ Advanced Digitizing Toolbar
Attributes Toolbar

< |

AutoFields
Database Toolbar
v Digitizing Toolbar
v DigitizingTools

v Help Toolbar

Label Toolbar

MO - TGN ARCPPRRCE -

b. Use “Enable tracing” button to easily follow property boundaries of layer
“0214_Eiendom teiggrense (Linje)’

Project Edit View Layer Settings Plugins Vector Raster Database Web  Progessing

NEBERLRR SO &0 080D D Q4
P7B® - d=<e B LS %

c. Begin by drawing polygon around the estate boundary clicking in each corner /
all arcs of the polygon. Make sure your internet connection is working and that
the map image is updated before continuing to digitise nodes of the polygon.
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d. Finish by right clicking inside created polygon. Fill in required information about
ID and Locality_number (allowed values integer from 1 to 10)

BGF_locality_area - Feature Attributes

id [1

Locality Mumber |1

photo_loc
MULL

|| Lecality Area (m~2) 17530.44

L~ 0 . -
@)
q

|

[ oK H Cancel ]

e. Optionally fill in overview photo of the locality (or fill it later with the “Identify
Features”, see below).

f. Press “OK”

g. If you do not want to save the polygon select "cancel".

4. To see properties for a polygon use “Identify Features” button a:’s .

a. If editing mode is turned on, you can also edit the properties through
“Identify Features” button.

b. Make sure to have “Auto open form”in the “Identify Results” enabled

ety esurs =

BAGdg=08e

Feature
4 BGF..

4 id
>
M

»

Value

MULL

m

MULL
A4 Impermeable surfaces with drainage to a local dose...

Blue-Green Surfaces
Eqg. concrete, asphalt, roof surfaces with runoffled to a...

MULL

-

View

iree

Mode |Layer selection - Auto open form
e —
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/&
5. To change corners/nodes, press “Node Tool”

a. To add new nodes - double-click between two existing nodes where want the
new node to be created.

b. To move nodes, mark the node (becomes blue square), then drag to the new
position

c. Toremove points, mark the node (becomes blue square), then press "Back-
space" on the keyboard.
apg
6. To split a polygon into two use button "Split Features" “* . Draw a split by cutting the
polygon on both sides, then right-click.

7. To merge polygons

a. you first have to select the polygons to be merged by using “Select Features”

........

2 (selected polygons are in yellow)

®

c. Select which of the merged polygon’s properties you want to maintain in the
pop-up window (the properties that are retained appear in the row called
"merge").

b. join polygons with “Merge Selected Features” button

8. Use button “Save Layer edits” often B

9. When done digitizing exit editing mode by clicking on “Toggle Editing” pencil.

Project Edit Vew Layer Settings Plugins Vector Raster

NEEERRR SO 20,
PUBI® -z @ <o B

v,, Layers Panel g X
4] QI_@;[@T"’{['E“‘-_.[_‘I‘Q
o | ¢ ¥ BGF_flate -
& :_-ﬁ BGF locality area P | |

10. Save the whole project by clicking on “Save” button

Project Edit View Lg

N EEIR !
= 0§ Q= %)
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So far, there is a maximum limit of 10 localities within one open BGF-QGIS Project. If you need
to map more localities, then you have to open another separate instance of QGIS

3.2 Other features

1. To zoom in / out, or move to a new location on the screen, use one of the buttons here:

O BBIP 5 5

Select polygon with % . By drawing a square around polygons, all within the

2.

square is selected. Other ways of selecting polygons can be found by pressing on the

black arrow.

(=)
3. Remove selection of selected polygons with =~
=

4. Delete a selected polygon by pressing
5. Measure distance by button. Choose "target line" on the black arrow if it does

not come automatically).

i
6. Measure area by @ (choose "target area")
3.3 Snapping Options

1. Adjust snapping options (Settings -> Snapping Options) for the different stages of
mapping process according to your needs (recommended value 10 pixel units).

HEEE]

Layer

BGF_flate

BGF_locality_area

0214 _Eiendom teiggrense (Linje)
Bygning_polygon

Mode

to vertex and segment

to vertex and segment

to vertex and segment

to vertex and segment

Tolerance
10.00000
10.00000
10.00000
10.00000

Units

= |[pixels

Avoid intersections

a

|| pixels

]

= pixels

|| pixels

]

Enable topological editing Enable snapping on intersection

OK.

) o |

Applv]

2.

It is also recommended to keep “avoid intersections” enabled for the first stage

of mapping (BGF1 - Blue-Green Surfaces), as here we will have to cover the
whole locality area without gap and overlap.

19 o]
Layer =
X nits woid ntersecti
V10214 Hendon (miogrence (inje) [to vertex snd seament_~ ol -
I BGF_flate s 10.00000 = [pixels v
BGF_locality_area 10.00000 | pixels. i
Bygning_pelygon ver ent v | 10,00000 = [pixels 5 ]
Enable topological edting 7] Enable snapping on intersaction Cancel
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This way, when mapping a lawn around an already created building polygon, this will be
clipped away automatically.

3. For the second stage of mapping (BGF2 - Additional Qualities) you must have “avoid
intersections” disabled. This is important to be able to place/map additional qualities on
top of Blue-Green Surfaces (enable overlaps).

3.4 BGF1 - Blue-Green Surfaces

The main part of the project is to map Blue-Green Structures within a locality. You do that by
assigning BG factor attributes to each mapped polygon. The mapping is divided into two stages
BGF1 mapping surfaces and BGF2 mapping additional qualities.

1. Digitizing BGF inside LOCALITY 1
a. Select layer “BGF_flate”

b. Repeat steps 1 (turn on edits) and 2 (add new polygon) as in section 4.1 Locality
level

2. Start with digitizing large structures in the Blue-Green Surfaces - BGF1 level (see sec-
tion 4.6 STRUCTURE below.)
a. You can use the raster layer “Bygning_polygon” to help you with digitizing build-
ing structures
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3. Choose option “Blue-Green Surfaces” after finishing drawing a polygon
ot tae reawe e AN W &
|

mapping level: -

Blue-Green Surfaces I Ly
Additional Qualities

BLUE-GREEN FACTOR

4. Based on your choice, new menus will become available.

0T fate - Festre Avviee: NN NN ¢ . © DO - T T

mapping level: |Blue-Green Surfaces
Blue-Green Surfaces
- -

BLUE-GREEN FACTOR
BLUE-GREEN SURFACES

BlueGreen Surface [AE: Surfaces with vegetation, not associated with sail > 80 cm - ]

BlueGreen value (o8 -]

B surfaces description | Vegetation growing in soil on minnimum 80 cm depth, but not in contact with the earth / ground below, eg. on top of a garage or roof. The depth is great enough that larger trees can grow. = |

Add, qual label IVeg surface infltration »30cm v] I

o] (o

5. According to the structure, choose one of the 9 available Blue-Green Surface types.
Use description to know more about the BG surface type. To confirm polygon creation
click on “OK”.

6. Polygon with a label will show up on your map
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7. Inspect created polygon for mistakes and topology errors (green cross instead of a red

node)
a. Topology errors should be avoided at all costs. To learn about what happens

when you have topology errors see section 4.7 Topology checker.

8. Adjust vertices in case necessary

Project Edit \Wiew Layer Settings PFlugins  Vector
[ EPJ SRR
ravi .E 1! Cﬂ.n]} >¢

Layers Panel

R Fe Nn:nde Tool
[ ] e

9. Save edits to the “BGF_flate” layer often. This helps you not losing your data and to up-
date information in the attribute table.

Project Edit View Layer Settings

B B
(o~ 8

Layers Pa h‘
i

g pPe

10. It is important to map the whole area of each locality using one of the Blue-Green Sur-
faces before you start adding Additional Qualities. This is because the blue-green fac-
tor is standardised by the total property area. If some surfaces are left out it will bias

the overall BGF downward
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11. In order to reuse the attributes from the previously mapped polygon, go to

3

Settings -> Options -> Digitizing -> “Reuse last entered attribute values’

|, i Dty — |2 ||
) w Feature creation
Suppress attribute form pop-up after feature creation
Reuse |ast entered attribute values I
Validate geometries [QGIS - ] |
I
¥ Rubberband

Don't update rubber band during node editing

¥ Snapping

Open snapping options in a dock window (QGIS restart required)

Default snap mode Ooff -
Default snapping tolerance 0.00000 2]
Search radius for vertex edits 10.00000 B

¥ Vertex markers

Show markers only for selected features

Marker style Cross - ]

Marker size 3

W Curve offset tool

Join style Round v]
Quadrant segments 8 E
Miter limit 5.00 =

[ o< J[ cond J[ reb

12. Optionally you can check the progress of you mapping by hitting the “Show Statistical
Summary” button on the Attributes toolbar (and choosing the correct layer i.e.
“BGF_flate” to display summary for)

ac-iy-g-LEEEE-¢m-
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3.5 BGF2 - Additional Qualities.

Additional qualities are mapped on top of Blue-Green Structures, and thus can overlap. If you
have enabled “avoid intersections” (step 3. in section 4.2 you have to turn it back OFF for layer
“BGF flate”.

For better visual inspection of the aerial image for Additional qualities, you might want to turn off
“visibility” of some of the already mapped polygons from BGF1 level. You do this in the Layers
Panel.

4 [/ ¥ BGF flate
@D Open permanent water surface that can recei...

Partially permeable serface like gravel, crushe...

Impermeable surfaces with drainage to veget...
Impermeable surfaces with drainage to a local...

Surfaces with vegetation assodated with soil ..

Surfaces with vegetation, not assodated with...

Surfaces with vegetation, not assodated with...

Surfaces with vegetation, not assodated with...

Surfaces with vegetation, not assodated with...

EBlue additional qualities
Green additional qualities - trees

Green additional qualities - other
Connection of structures

MNOT MAPPED PROPERLY

el EEEEEREEE

1. In the dropdown menu for mapping level, choose Additional Qualities (see section 4.8
STRUCTURE below.)

BGF _flate - Feature Attributes @

mapping level: -]

Blue-Green Surface
 Additonal Qualities x

BLUE-GREEN FACTOR

2. Select corresponding group of additional qualities from four available options

o7 e e e I g

mapping level: |Additional Qualities - ]

BLUE-GREEN FACTOR
ADDITIONAL QUALITIES

Group of additional qualities k vl'
Blue additional qualities

Type of additional blue

Green additional qualities - other
Connection of structures

Type of additional qualities

Additional quality value

Add. qual. description

BG surface label

Add. qual code
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3. Finally, when all desired information is filled based on your choice.
ate polygon.

BGF_flate - Feature Attributes

Click on “OK” to cre-

@
mapping level: [Addih‘onal Qualities - ]
BLUE-GREEN FACTOR
ADDITIONAL QUALITIES
Group of additional qualities [Green additional qualities - trees (filled in as a number) - ]
Type of additional blue green quality
Type of additional qualities [Cl Closed canopy trees (% of total area) - ]
Additional quality value [1.0 - ]
Add. qual. description [Total area of dosed tree canopy. Factor: dosed_canopy_area m2/total_locality_area (x 1). V]
BG surface label [Clcsed canopy trees V]
Add. qual code [CCT V]
4. Atthe end, you should end up by digitizing all Additional Qualities of a locality

weﬂﬁ?&%
nooseeeeeet P T any tus
88
PPN 4
seee8ed® 4
apeeeeeeeee‘?'*’eeee : Closed Ganopy trees %}
- )
P y
S Closed candpy trees Indidualtree 3
% Indhidialbrea | IndVidual tree Cwuw‘&
. M. ¥
® S B '3
LY Closed mnnpyh“ses*”_ B _792_7\_33@@!(!& %
) ‘Closed canapy trees — e ] ]
LY ! f‘ — Pl % W
% \ T"’{ = L— 1 Indvitialtree Closed canopy fbes \
L \ \
Andividual tree e Y 1 | “ ] \
k' AN — | \
AN LA - R .
; T — \ (L 4
Cinavicue tree \_ |ty 3
& e I r Tncidualtree | 3
y Closéd canopy trées i ! Crfl e s
K ®
L - T \
* Closed canopy trees Closed canopy trees ‘%
)
| E@@ Closed CANOPY 1225 (g idua tree (1
| 4 Closed canopy trées § L ]
{ i ] %
E < Indwidualtree . E_)Sbﬂd ooy tees 3
updvasies Heuhes P \ 8
—~7 N&w T T{J_ | Indviialtree
< \ : [ .
(> ( L\\ | | Closed canopy rees
‘f/’ Y sl ree \ Erens
\ VA \ s ‘
1 1<y G ] \
™ o Indvidual tr P
e L4 widual tree. , WD) eseeee
"2 [ L) . Closed canopy trees Sheeve®
. s fndidal e i Y veeese®
- - % ceeee®®s”
\ e
| S Close canopy tress, |||y e T
- | e
| % et

=7 &
5. In many cases already mapped surfaces will also take on qualities in the same poly-
gon, f.ex. green space > 75m2. To copy an existing polygon from BGF1 - Blue-Green
Surfaces, and assigning it an BGF2 — Additional quality value, first select the chosen
polygon with “Select” button. Then click “Copy” button (or Ctrl+C) and subsequently

“Paste” button (or Ctrl+V). The polygon is now be copied over the original one (Note:
“Avoid intersections” in snapping options have to be unclicked).

VB Rro-Brx i >

EiNE|

Now press “Identify Features” button to adjust attributes for the newly created polygon.

6.

IMPORTANT: If, after you have created a polygon, it does not have a label or is col-
oured with red “NOT MAPPED PROPERLY”, you have to check and correct it. Python-
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init function in QGIS forms should also warn you about such cases before they are en-

tered.

4 " BGF flate
l:l Cpen permanent water surface that can recei...

Partially permeable serface like gravel, crushe...

Impermeable surfaces with drainage to veget...

Impermeable surfaces with drainage to a local ..

l:l Surfaces with vegetation assodated with sail ...

Surfaces with vegetation, not associated with...

|| Surfaces with vegetation, not assodated with...
|| Surfaces with vegetation, not assodated with...
|| Surfaces with vegetation, not assodated with...
l:l Blue additional qualities

Green additional qualities - trees
Green additional qualities - other
Connection of structures

EEEEEEEEEEEE

NOT MAPPED PROPERLY I

The reason is that not all the required fields have been filled and thus the BGF cannot
be calculated. Make sure to fill attributes before clicking OK.

st - st it T =)

mapping level: |Blue-Green Surfaces

BLUE-GREEN FACTOR

BLUE-GREEN SURFACES

BlueGreen Surface

BlueGreen value

BG surfaces description

Add. qual label

BG surface code

> S
"

Future improvements:

level.

BGF1 and BGF2 will be available as two separate layers, which
will simplify the attribute table and make the form value relation
unnecessary. We plan on using Spatialite or GeoPackage and
then having spatial views for aggregating data into the locality
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3.6 Structure overview
The following lists the blue-green structures implemented in the BGF methodology.

BGF1Blue-Green Surfaces
A. Blue-Green Surfaces

A1. Open permanent water surface that can receive rainwater

A2. Partially permeable surface like gravel, crushed stone, and reinforced grass sur-
face

A3. Impermeable surfaces with drainage to vegetated areas or an open drainage
magazine

A4. Impermeable surfaces with drainage to a local closed storm water drainage

A5. Surfaces with vegetation associated with soil or bedrock

A6. Surfaces with vegetation, not associated with soil > 80 cm

A7. Surfaces with vegetation, not associated with soil 40 - 80 cm

A8. Surfaces with vegetation, not associated with soil 20 - 40 cm

A9. Surfaces with vegetation, not associated with soil 5 -20 cm

BGF2Additional qualities

B. Blue additional qualities
B1. Natural edges to water surfaces
B2. Rain bed or equivalent

C. Green additional qualities - tree canopy

D. Green additional qualities - other
D1. Native vegetation
D2. Hedges, bushes and multi-stemmed trees
D3. Green walls
D4. Perennials and other ground cover
D5. Contiguous green areas over 75 m2

E. Connectivity of structures (filled in with the number 0,05)
E1. Connectivity to an existing Blue-green structure.

3.7 Topology checker
It is important that the topology in the map be correct! Errors often appear with a green cross:

-

Or when you see such orange warning about GEOMETRY ERRORS.

.:] / 1 \ Add feature: segments 1 and 3 of line 0 intersect at 6800881.451971, 6615246.43773 Geometry has 1 errors. Validation finished

Failure in topology causes problems with snapping, and should be corrected as soon as they
occur.

Errors can often be corrected by moving or deleting additional (green) nodes
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1) You can check for errors in topology by navigating into
a. Vector -> "Topology checker"

=¥
2) Add topology rules by pressing Al Using the rules you set a verification procedure
checks already created polygons for errors. The rules must be added for the layer

"BGF_flate"
4 — ER=)
/" Topology Rule Settings
Current Rules

I[EGF_ﬂaDe vl] I.must not have invalid geometries 'I

i Add Rule || |= Delete Rule

Rule Layer #1 Layer #2  Tolerance
1 must not have invalid geometries BGF_flate Mo layer Mo tolerance
[ OK ] [ Cancel ] [ Help

a. Useful rules are "must not have invalid geometries"
b. and "must not have gaps".

3) Check if the topology of your map is correct by pressing v

4) BGF for polygons with invalid geometries will still be calculated. However, it will not be
possible to further snap towards this incorrectly created polygon.
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4 Browsing through registered data

Throughout the mapp|ng/d|g|t|2|ng process, you can check the registered data in attribute table.
Ma]g - _Iﬁ Y - [Tl

For example it is useful to check for the polygon area, polygon BGF or the final BGF for the
whole locality. Otherwise, you find all the data about BGF type codes, descriptions, labels or
percentage of mapped area.

You can go back and change some of the attributes by using “Identify Features” button % .

To check statistical summary of registered data use Z button (for more info, see 10.4 - How

to calculate simple statistics for total BGF score)

The following fields are being registered while you digitize BGF into polygons. Each of the fields
has its function in final calculation of BGF. (see section APPPENDIX for more details about code

used.)
Attribute name Attribute Description
Id ID number
1_BG_surf Blue-Green Surface
1_BG_val Blue-Green Surface Value
2 BG Group of Additional Qualities
2_BG_type Additional Quality type
2_BG_val Additional Quality Value
0_BG_level BGF level
1_BG_descr Blue-Green Surface — Description
2_BG_descr Additional Qualities — Description
Photo link to picutre of polygon
2_BG_label Additional Qualities — Label
1_BG_label Blue-Green Surface — Label
1_BG_lab_c Blue-Green Surface - Label shortcut
2_BG_lab_c Additional Qualities - Label shortcut
BGF_locality_area_loc_area Locality area
Area Polygon total area (in m~2)
BGF1 BGF for Blue-Green Surface polygons
BGF2 BGF for Additional Qualitiy polygons
BGF_Code BGF code
Loc_num Locality number
tot_BGF1 Total BGF1 - surfaces for each locality
tot_BGF2 Total BGF2 - additional qualities for each locality
MappedArea fraction of mapped area/total area
E1_connect Connectivity found? (Y/N)
BGF_final Final BGF score for each locality
BGF_contrb Per-cent contribution of a given polygon to the total locality BGF
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5 Final BGF score

The most important part of the whole mapping and digitizing is a final score for Blue-Green Factor
for each locality. This value is displayed in the last column of attribute table “BGF _final”. The
value is specific for each locality, but same for each mapped polygon within a locality.

/| BGF flate : Features total: 64, filterad: 64, selected: 0 | e S
/2B DD & L TEXD D06 B =
I Locality_number I mapped areatotal area Palygon Photo BG surface label Add. qual label E1_connect BG surface code Add. qual code | BGF_final I &

43 1 1,988 NLEL Drainage to grou... ML | DGW NLEL 0.833

50 1 1.988 NLEL Impermezble ope.. 0.833

51 1 1.988 NLEL Drainage to grou AMULL | DGW NLEL 0.833

52 1 1.988 AL Drainage to grou AL DGW ALEL 0.833

53 1 1.938 ALELL Drainage to grou... MLLL DGW AMLEL 0.833

54 1 1.988 ALEL Drainage to grou... ML DGW MLEL 0.833

55 1 1.938 MNLEL Drainage to grou... MLLL DGW ALEL 0,833

1) 1 1.988 MNLEL Drainage to grou... MLLL DGW MLEL 0.833

57 1 1.938 MNLEL Drainage to grou... MLLL DGW MLEL 0,833

58 1 1.988 ML Impermeable ope.. ML IOD MAEL 0.833

59 1 1,988 ML Impermeable ope.. ML IOD ML 0.833

60 2 1.000 ML Impermeable dos.. ML ICD ML 0.472f —
61 2 1,000 NLEL Impermeszble dos.. MULL | ICD NLEL 0.472

62 2 1.000 NLEL Impermezble ope.. MULL | TOD NLEL 0.472 |E
63 2 1,000 NLEL Vegetation +sail ... MNLLL V580 NLEL 0.472

64 1 1983 Individual tree ML ML | MUEL SMT 0.833
] 1 | v
T show All Features,| u[_']

The field “BGF_contrb” registers the per-cent contribution of a given polygon to the final BGF
factor.
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6 Export of registered data

Right click on the layer that you want to export and choose “Save as”. Choose “Comma sepa-
rated value [CSV]” format

Layers Panel A x

T &~ &L

E.. !oom to Layer 1

Show in Overview

[l Remove
L] Duplicate
Set Layer Scale Visibility
Set Layer CRS -
Browser Panel i
Set Project CRS from Layer
]
E‘l’ R v _1' Styles L
> ) Projecth 1
> || Home | Open Attribute Table 1
Favourite *  Toggle Editing
>4':;| Save As...
e Save As Layer Definithsh File...
Filter...
Show Feature Count
Server:  hitp
Properties
Login

Rename

- v-' - "
Y s -—‘.u e - -
.. Save vector layer as. ‘ L = =

Format kumma Separated Value [C5V] ‘Il
File name  |rial_export.csv Browse
Layer name

CRS selected CRS (EPSG:32632, WGS 84 / UTM zone 321) -8
Encoding lSysbem - ] =

Save only selected features

P Select fields to export and their export options

Add saved file to map

Symbology export Mo symbology - ]

Scale 1:50000

¥ Geometry E
Geometry type Automatic - ]

Force multi-type

Indude z-dimension

p [[] Extent (current: layer)

¥ Layer Options

CREATE_CSVT [NO |
GEOMETRY  [AS.XY -]
LINEFORMAT | <Defalt> -]
SEPARATOR  [COMMA -]
WRITE_BOM  [NO -]

[ OK ] [ Cancel ] [ Help ]

Your project database is now saved as CSV file, which you can open statistical software and MS
Excel). The statistical package “R” can read dbase files directly.

IMPORTANT: If you are to share your whole project (not only output), it is important to attach all
necessary files. This means not just the “project.qgs” file, but all vector, raster and table data.
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The easiest way is to Use QConsolidate (if you did not use server-databases that may become
inaccessible).

b csv
|| DOCUMENTATION
| STYLE

| VECTOR

| "« BGF_qgis_ project.qgs

| BGF_ggis_project.qgs.bak

A,

| BGF_ggis_project.qgs.bak~
|| BGF_qgis_project.qgs~ BGF_final.zip
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7 Sending your data to CLOUD

If you have installed the optional plug-in QGIS Cloud Plugin during step 2.5 Optional Plugins,
you only need to create a free account to share your data with other QGIS users. You do this by
following instructions on the sign up page of QGIS Cloud
(https://qgiscloud.com/en/account/sign_up).

Now you have to enable the QGIS Cloud Plugin through
View -> Panels ->QGIS Cloud.

After creating an account you sign in using your credentials into QGIS Cloud Plugin through
QGIS

&QGIS Cloud 5o
Map | Upload Data Account ml—
Server:  https://api.qgiscloud.com E]

Databases

By sending your data to the QGIS cloud you can share it with your colleagues or make it avail-
able to the public.

When uploading your data to the QGIS Cloud, keep in mind which of your layers might have
restrictions on being publicly shared (ex: some raster layers or property data).
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8 Communicating your results

8.1 Map output (Print Composer)

Usually, the process does not end by mapping an area for BGF. Some sort of output is required.
You can present your data in several ways. For example by producing a Map Layout in “Print
Composer”. Learn more about how to create layouts in the QGIS Tutorials:
https://docs.qgis.org/2.0/en/docs/user_manual/print_composer/print_composer.htmi

Example output Map of the As Municipality area:

BLUE GREEN
FACTOR in QGIS

Locality number 1

FINAL BGF SCORE = 0.871

10 0 10 20 3 4m @

Legend

BGF_flate [ ] A8 Surfaces with vegetation, not associated with soil 20 - 40 cm
[ Open permanent water surface that can receive rainwater [7] A9 Surfaces with vegetation, not associated with soil 5 -20 cm

Partially permeable serface like gravel, crushed stone, and reinforced grass surface || Blue additional qualities

. Impermeable surfaces with drainage to vegetated areas or an open drainage magazine 1 Green additional qualities - trees
Impermeable surfaces with drainage to a local closed storm water drainage [T Green additional qualities - other
[ Surfaces with vegetation associated with soil or bedrock [77] Connection of structures
A6 Surfaces with vegetation, not associated with soil > 80 cm [T NOT MAPPED PROPERLY
[ 1 A7 Surfaces with veqetation, not associated with soil 40 - 80 cm 223 BGF_locality_area

Many other customization options exist in QGIS. You can change the colour scheme or labels
and tweak your final map layout into perfection. (see hints and tutorials below)

http://docs.qgis.org/2.0/ca/docs/training_manual/basic_map/symbology.html

http://docs.qgis.org/2.0/ca/docs/training_manual/vector classification/label tool.html

https://qgis.stackexchange.com/questions/3083/what-makes-a-map-beautiful
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8.2 Data output (Excel, R, Matlab ...)

You can also export you final data into a CSV table (as shown in section 7 Export of registered
data) and analyse them with your favourite statistical program. (Advanced users can also do
analyses without data export within QGIS, e.g. using R script in Processing or statistical sum-
mary plugin.)

Here we produce summary diagrams in Excel. Some examples are provided below, but de-
pends only on your imagination/needs. NOTE: you will have to do some data clean-up before
analysis.

Sum of area Sum of area

BG_label -
Total mapped Area Total mappEd Area = Closed canopy trees

Connectivity

= Drainage to groundwater

= Hedges, bushes
= Impermeable closed
' drainage

m [mpermeable open
drainage

= Individual tree
Open permanent water

= Vegetation+soil > 80 cm

= Vegetation+soil 20-40 cm

0_BG_level -
= Additional Qualities

u Blue-Green Surfaces

Sum of BGF
o BG_label -
BGF contribution = Closed canopy trees
= 0%
o 0%
sy mO0%_"2% 0% Connectivity

1
3%

" 0%__ 48

= Drainage to groundwater
m Hedges, bushes

= Impermeable closed
drainage

® Impermeable open
drainage

u Individual tree

.3%/

0% Open permanent water
= Vegetation+soil > 80 cm

m Vegetation+soil 20-40 cm

8.3 Highlighting selected features of your project — focusing your
message

In some cases you may wish to highlight some blue or green features in the map of your locality.
For example, it could be that a selection of trees on the property will be cut, perhaps to be com-
pensated with the same or larger tree canopy elsewhere with newly planted trees. You wish to
highlight these qualities in a separate map, and calculate the BGF score only for this subset of
qualities (in order to illustrate the amount of BGF that needs to be compensated).
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First, select the features you wish to highlight (e.g. individual trees) by identifying on the map, or
by their attributes.

1. To extract attributes of the selected features with selected fields for calculation

a. You can select features either by attributes

o Syl Label Rule . Min. scale  Max. scale

D Open per... "1_BG_surf'= 'A1
Partially ... "1_BG_surf' = 'A2'

€I= Labels
: Imperme... "1_BG_surf' ='A3'
|- Fields 1 Imperme... "1_BG_surf' = 'A4’
[ ] Surfaces ... "1_BG_surf' = 'A5'
‘?'/ Rendering A6 Surf... "1_BG_surf' ='A6'

il 1 -

Refine selected rules

w Layer rendering

[ER piagrams Layer transparency
fi Meiadata Layer blending mode Normal E
Variables Feature blending mode Normal | <]
Legend | Draw effects
| Control feature rendering order
Help Style v Apply
Label trees_remove
Filter | vig' = 42 OR "id" = 43 OR "id" Test
Description
| Scale range
Minimum (exclusive) Maximum (inclusive)
= 1:100 000 v || K == 1:1000 v || B
& Nl - Wi
Symbol
v
|| Simplefil
s A —

b. Or select manually
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2. Save selected features as CSV, see section “7 Export of registered data” in this
manual. Additionally tick “Save only selected features” and unselect the fields you
don’t need in the list of “Select fields to export”:

Format Comma Separated Value [CSV] d
File name Browse
Layer name
CRS Selected CRS (EPSG:32632, WGS 84 / UTM zone 320 d 2
Encoding System | <]
In Save only selected features '
v t s to export and their export options
Name Type Replace with displayed values
id Integer64
| 1_BG_surf | String Use Value Relation
1_BG_val | Real Use Form Value Relation
2 BG String Use Value Relation
2_BG_type | String Use Form Value Relation
| 2_BG_val | Real Use Form Value Relation
Select All Deselect All
Replace all selected raw field values by displayed values
Help Cancel OK

3. Alternatively you can create a new layer from selected features
a. Select the features you wish to highlight
b. Right click the “BGF_flate” layer -> Save as:

7/ Save vector layer as...

Format ESRI Shapefile ‘_“I o

e

Layer name

CRS Selected CRS (EPSG:32632, WGS 84 / UTM zone 32F <] 2

Encoding System | ]
| Save only selected features |

their export options
Add saved file to map Save As: | treeq v
Symbology export No symbology <] Tags:
Where: | [ BGF final IJ
Help Cancel OK
Cancel | [l

c. Choose ESRI Shapefile as Format. Other formats can be found at http://switch-
fromshapefile.org/

d. Click Browse for File Name, where you name this new layer with selected fea-
tures, e.g. “trees”, and choose where you want to store the new vector layer

e.

Tick save only selected features.

By doing this, you create a GIS shapefile stored as several specific files.
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Now you have a subset of the “BGF _flate” with only the selected features, where you can either
extract attribute table or define how you highlight them. More instructions for setting symbology
see section 9.1 Map output (Print Composer).

An example of the outcome of highlighting selected features in 2 ways with As Municipality area:

[xX ] Layers Panel
« @ ® T &y B & O

|| trees
trees_temp
. /| = BGF fiat
- Open permanent water surface that ...

Partially permeable serface like grav...

{1 Impermeable surfaces with drainage ...
Impermeable surfaces with drainage ...

. Surfaces with vegetation associated ...

|| A6 Surfaces with vegetation, not as...

D A7 Surfaces with vegetation, not as...

D A8 Surfaces with vegetation, not as...

D A9 Surfaces with vegetation, not as...

. Blue additional qualities

Green additional qualities - trees

[7] Green additional qualities - other

D Connection of structures

. NOT MAPPED PROPERLY

trees_remove
lector_data

—— 0214_Eiendom teiggrense (Linje)
Bygning_polygon

WMS_raster_data

"~ B BYGNING

| ™ EIENDOMSKART

Impermesble closed drainage

Heescsocsossoooe

<]

P
O

[ o0 =

P
44“
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9 Adjusting advanced settings in BGF-QGIS project

It is possible to make changes to the internal “core” information for BGF-QGIS system. In par-
ticular criteria can be added/removed/edited and the weighting can be changed. All this core
information is stored in CSV files inside folder “CSV”.

9.1 How to restore default layer style again

If any unwanted changes have happened in BGF_flate layer (for example colors, labels or cal-
culations have changed), you can load a layer style from a previously saved file. Do this by
navigating into “BGF_flate” layer (in layers panel) - > layer properties -> Style (button in the
lower left corner) -> load Style. Now navigate to style file in our project folder and subsequently
subfolder “BGF _final_clear” -> “STYLE” -> “bgf_final_10.gml”

9.2 How to add, remove, edit description of BGF-QGIS criteria.

All values and names are stored in file folder named “CSV” in the files “0_EN.csv’,
“1_EN_bluegreen_areas.csv”, “2_EN.csv’ and “BGF_EN.csv”. In case you decide to adjust
some of the information (description, new parameters), this can be done through changing one
of the abovementioned files. Notice that the QGIS project needs to be closed (and saved) at this
point.

9.3 How to change weighing of BGF

In case you decide to adjust weighing system of BG surfaces, this can be done through changing
file named “BGF_EN.csv” in file folder CSV. Notice that the QGIS project needs to be closed
(and saved) at this point. After opening the file “BGF_EN.csv”, change appropriate weights in
column “value” for given Blue-Green Surface or Additional Quality.

9.4 How to calculate simple statistics for total BGF score

Choose
View -> Panels -> Statistics Panel.

Statistics Panel =] S Seatist m B ——— CF
(BGF flate | - -
_| Layer iz analyse SGF_Ffane - * * + + 0. E H:u ,p’ ol
1.2 BGF_final | - £ Use anly seleci=d fezturss
Statistic value o Target Fiekd 12 BGF_fina - Frequency distribution
Sum 34828 Suatistics [ 60
Coun 4
Mean 0.544187 o ¢ 1
I Unigue values
Median 0.549 £ 4
I Winimum velue 2472
Std 0.0186387 Y |
| v (pop) Marwmivabe 0549 o
St dev (sample) 0.0187861 I Ranoe o077 20
Minimum 0.472 Sum HEE wl
l o — L&D Mezn walue CE4A1ETE |
]
Mzdian valuz 0.549
Range 0.077 o P gt
Standard deviat.. | CU018E307303536 BGF fina
Minority 0.472 = I - L -
Selected features only ] |:| [ o Cme

OPTIONAL: To display a histogram of values for a desired field in addition to basic statistics, you
can use plugin “Statist” (which you install using same procedure as mentioned during step 2.2
Required Plugins).

42




NINA Report 1445

9.5 File structure in the MAIN folder

MAIN folder is named “BGF _final” and inside you find the following sub- csv
structure DOCUMENTATION

e (CSV —contains all spreadsheet tables with data gfm
e DOCUMENTATION — tutorial for use of the BGF-QGIS project

BGF_ggis_project.qgs

e STYLE — QGIS style file for “BGF_flate” layer containing field struc- L ST St
i - || BGF_ggis_project.qgs.bak~
ture, label and colour coding [ BGF_qgis_praject.qgs~

e VECTOR - all vector files used in the project (ex: BGF_flate,
BGF_locality_area, property borders)
e BGF_qgis_project.qgs — project file to be OPENED

Future improvements:

We plan on using Spatialite DB instead of the current filesystem.
This way all data (except documentation) can be stored in SQL
format. This will allow also spatial views for aggregation and
make some of the plugins unnecessary.
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11 APPPENDIX

11.1 Abbreviations, description and diagram for BGF structures in
BGF-QGIS

Code | Short label | Description Value Picture
Al OPW Open permanent water surface that can receive rain- 1
water -
Partially permeable serface like gravel, crushed stone,
A2 PP . 0.3
and reinforced grass surface !
Impermeable surfaces with drainage to vegetated ar-
A3 10D eas or an open drainage magazine 0.2 %
AL 1D Impermeable su.rfaces with drainage to a local closed 01
storm water drainage O
AS DGW Surfaces with vegetation associated with soil or bed- 1 i |
rock =
AG V580 Surfaces with vegetation, not associated with soil > 80 08 i 1l
cm
A7 VS40-80 Surfaces with vegetation, not associated with soil 40 - 06 Ll
80 cm e
AS VS$20-40 Surfaces with vegetation, not associated with soil 20 - 04 H i
40cm o
A9 VS5-20 Surfaces with vegetation, not associated with soil 5 - 0.2
20cm
Bl NWE Natural edges to water surfaces 0.3 —
B2 RB Rain bed or equivalent 0.3 Jﬂﬁﬁﬂm
(% of total | £ \ \f‘
C1 CCT Tree canopy area) (\v
D1 NV Native vegetation 0.6 AR
D2 HB Hedges, bushes and multi-stemmed trees 04 i
D3 GW Green walls 0.4 ﬂ
D4 PP Perennials and other ground cover 0.3 5 v e
& it
D5 GA Contiguous green areas over 75 m2 0.1 75m2
E1l C Connection to an existing Blue-green structure. 0.05 *

45




NINA Report 1445

11.2 Code used in calculations of virtual fields:

#### BGF1
$area * "1 _BG_val"

##t## BGF2

CASE
when "2 _BG_type" = 'C1'
then ($area / "BGF_locality_area_loc_area" ) * 100
when  "2_BG_type" = 'C2'

then ($area / "BGF_locality_area_loc_area" ) * 100
else $area * "2 BG_val"

END
#### BGF_CODE1
concat(
left( "1_BG_surf" , 1) ,
left( "2_BG_type" , 1)
)

#it## LOC
geomintersects( 'BGF_locality_area', 'loc_number')

#### tot_BGF1

CASE

when "loc_num" =1

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=1 )
when "loc_num" = 2

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=2 )
when "loc_num" = 3

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=3 )
when "loc_num" = 4

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=4 )
when "loc_num" =5

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=5 )
when "loc_num" = 6

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=6 )
when "loc_num" = 7

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=7 )
when "loc_num" = 8

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=8 )
when "loc_num" = 9

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=9 )
when "loc_num" = 10

then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=10 )
else NULL
END

#i#t## tot_BGF2

CASE

when "loc_num" = 1

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=1 )
when "loc_num" = 2

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=2 )
when "loc_num" = 3

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=3 )
when "loc_num" = 4

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=4 )
when "loc_num" =5

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=5 )
when "loc_num" = 6

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=6 )
when "loc_num" = 7

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=7 )
when "loc_num" = 8

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=8 )
when "loc_num" = 9

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=9 )
when "loc_num" = 10

then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=10 )
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else NULL
END

#### mapped area
CASE

when "loc_num" =1
then aggregate( 'BGF_flate', 'sum',
when "loc_num" = 2
then aggregate( 'BGF_flate', 'sum',
when "loc_num" = 3
then aggregate( 'BGF_flate', 'sum',
when "loc_num" = 4
then aggregate( 'BGF_flate', ‘'sum',
when "loc_num" = 5
then aggregate( 'BGF_flate', 'sum',
when "loc_num" = 6
then aggregate( 'BGF_flate', ‘sum',
when "loc_num" = 7
then aggregate( 'BGF_flate', 'sum',
when "loc_num" = 8
then aggregate( 'BGF_flate', ‘sum',
when "loc_num" = 9
then aggregate( 'BGF_flate', 'sum',
when "loc_num" = 10
then aggregate( 'BGF_flate',
else NULL

END

#### E1

case
when "2_BG_type" = 'E1l' then 0.05
else NULL

end

#### BGF_final
case

when "Loc_num" =
then if(aggregate('BGF_flate' , 'count_distinct', "E1",

1

"area",
"area",
"area",
"area",
"area",
"area",
"area",
"area",

"area",
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filter:
filter:
filter:
filter:
filter:
filter:
filter:
filter:=

filter:

="loc_num"=5

="loc_num"=1 ) / "BGF_locality_area_loc_area"
="loc_num"=2 ) / "BGF_locality area_loc_area"
="loc_num"=3 ) / "BGF_locality area_loc_area"
="loc_num"=4 ) / "BGF_locality area_loc_area"
) / "BGF_locality area_loc_area"
="loc_num"=6 ) / "BGF_locality area_loc_area"

="loc_num"=7 ) / "BGF_locality area_loc_area"

"loc_num"=8 ) / "BGF_locality_area_loc_area"

("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when

then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:

("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when

then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:

("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when

then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:

("tot_BGF1"+ "tot_BGF2") / "BGF_locality area_loc_area" when

then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:

("tot_BGF1"+ "tot_BGF2") / "BGF_locality area_loc_area” when
then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:
("tot_BGF1"+ "tot_BGF2") / "BGF_locality area_loc_area"” when
then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:
("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when
then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:
("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when
then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:
("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when

then if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 10) =

("tot_BGF1"+ "tot_BGF2") / "BGF_locality area_loc_area"

END

#i#t## BGF_contrb

if ( "BGF1" is not NULL,
("BGF1" / ("tot _BGF1" + "tot BGF2"
("BGF2" / ("tot _BGF1" + "tot BGF2"

))
))

* 100,
* 100)
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filter:= "Loc_num"

"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =
= "Loc_num"
"Loc_num" =

1)
2)
3)

4)

2

3

4

5

= 5)
6

= 6)
7
=7)
8

= 8)
9

9)
10

.05,
.05,
.05,
.05,
.05,
.05,
.05,
.05,
.05,

.05,

="loc_num"=9 ) / "BGF_locality area_loc_area"

‘sum', "area", filter:="loc_num"=10 ) / "BGF_locality_area_loc_area"

null)+
null)+
null)+
null)+
null)+
null)+
null)+
null)+
null)+

null)+
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